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Abstract 
The comparative analysis of microstructures of the built-up layers obtained by arc surfacing by pow-
der electrodes is carried out. The electrodes as filler contained prepared powder of titanium carbide 
in one case, and in another case, powder mix of titanium and technical carbon (carbon black), where 
the self-propagating high-temperature synthesis of  titanium carbide proceeded in case of thermal 
influence of electric arch. For the built-up layers, the complex of the structural parameters defining 
wear resistance under the conditions of friction on fixed abrasive is determined. Results of tests 
show that the wear resistance of layers applied at combination of arc surfacing with SPHTS is 1.27 
times higher relating to the layers, which are built up by electrode with prepared powder of titanium 
carbide as filler.
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ABRASIVE WEAR RESISTANCE, FIXED ABRASIVE



127Metallurgical and Mining IndustryNo.2 — 2016

Materials science
Wide use of composition materials carbide–metal 

matrix under the conditions of abrasive influence is 
caused by their high and stable wear resistance in the 
wide range of characteristics of abrasive and condi-
tions of abrasive wear [1-3]. Among all the widely 
applied carbides of high-melting metals, titanium 
carbide has the highest temperature of melt, and also 
hardness [4]. It causes increased scientific interest to 
the search of optimum structure of composite coat-
ings based on titanium carbide and ways of its main-
taining, including arc surfacing. 

Perspective method of an arc surfacing is its com-
bination with the self- propagating high-temperature 
synthesis of high-melting components [5]. The impact 
of such combination on microstructure of the built-up 
layer requires additional study as there are almost no 
data on results of similar tests in the literature.

Known methods of  stereometric metallography 
[6], which are conducted by the metallographic anal-
ysis with the subsequent measurements of structural 
parameters and their processing characterized by the 
considerable labor intensity caused by the necessity 
of measurement of a large number of data, often are 
in big error because of complexity of evaluation of 
the particles shape by means of simple geometrical 
figures. Recently, successful attempts of the analy-
sis of structure and phase composition of carbon and 
low-alloy steels are made [7], including the use of 
software “ImageJ” for processing of metallographic 
analysis results [8-9]. However, the requirements to 
quality of metallographic section and techniques of 
their etching will increase significantly, as even insig-
nificant violations introduce significant errors when 
preparing samples. The electron-microscopic meth-
ods of research in the mode of back-scattered electron 
diffraction (EBSD), in case of which the color satura-
tion is proportional to density of appropriate phases 
(structural components), do not contain abovemen-
tioned drawbacks. 

The purpose of work is comparative research of 
pictures of the microstructures obtained by electron-
microscopic method, determination of impact of a 
complex of structural parameters of microstructures 
under investigation on abrasive wear resistance of 
built-up coatings based on titanium carbide, which 
were applied by traditional arc surfacing with powder 
electrodes, and also by arc surfacing combined with 

the self-propagating high-temperature synthesis. Sur-
facing was conducted by powder electrodes of two 
types. The first type contained filler in the form of 
powder of titanium carbide, and the second one was a 
powder compound of titanium and technical carbon. 
Thus, self-propagating high-temperature synthesis of 
titanium carbide proceeded in case of surfacing by 
electrodes of the second type with their powder filler 
at thermal effect of electric arc. 

2. Materials and technique of researches
Surfacing material for applying of the arc coat-

ings under investigation was conducted in the form of 
powder electrode by cutting of a single-clamp band 
with the lapped lock to 400 mm long measured pieces. 
Design of the specified band is presented in Figure 1. 
Advantages of this design are the simple production 
technique, and also opportunity to obtain a high fill-
ing coefficient. Moreover, the position of the lock in 
a middle part of section of powder band is conductive 
to more uniform core melting [10]. The rolling mill 
for band cast tungsten carbide production developed 
by Paton Electric Welding Institute was used for pro-
duction of powder electrodes [11]. This rolling mill 
was equipped with the additional measuring device of 
conveyor type with the vibrator and special node of 
cutting as distinguished from prototype.

Figure 1. Design of powder band with the lapped lock:
1 – metal coating; 2 – powder filler

The coating is made of cold-rolled steel band 
of grade 08kp according to GOST 3559-75; it is  
0.5 × 20 mm in size and produced by JSC “Zapori-
zhia Iron and Steel Works “Zaporozhstal”. The pow-
der filler (furnace charge) is prepared by mechanical 
mixing of components, which grades are shown in 
Table 1.

Before weighing and mixing, components are 
carefully dried in the drying box such as SNOL dur-
ing 60 min at a temperature of 90 оС. In order to en-

Table 1. Filler components

Powder component Grade GOST, TR Size of particles, micron
Titanium PTKh-6-1 TR 49-10-78-83 60 - 88
Technical carbon (carbon black) K-354 GOST 7885-86 9 - 320
Titanium carbide Ch TR 6-09-492-75 20 - 40
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sure a high-quality mixing of components of powder 
filler, the laboratory V-shaped mixer of powders of 
C2K/6 grade is used. Time of mixing is 60 min with 
rotation frequency of 50 min-1.

The coefficient of filling of powder electrode is 
calculated by a formula:

 100% ,
G

pow
f

el

G
K = ⋅   (1)

where Gpow – mass of powder filler; 
Gel – total mass of powder electrode.
The coefficient of filling is controlled by series 

weighting of not less than three measured pieces of 
electrode by laboratory mechanical scales BA-4M.

Two types of powder electrodes are produced. The 
first type contains filler in the form of powder of ti-
tanium carbide, and the second one is powder mix of 
titanium and technical carbon taken in stoichiometric 
ratio (80% of Ti and 20% of C). The filling coefficient 
for both types of electrodes is 25%. The powder filler 
in the electrodes of the second type has provided the 
self-propagating high-temperature synthesis of tita-
nium carbide when surfacing under thermal effect of 
an electric arc.

Surfacing of materials under investigation was 
conducted in manual mode with use of the rectifier 
welder VDU-506. Surfacing mode has the following 
indexes: the volt-ampere characteristic is falling, the 
current is 160-180 A, arc voltage is 30-32 V, polarity 
is negative (plus is applied to electrode). Surfacing 
has been carried out on steel plates of 10 mm thick; 
material of plates is steel 45 according to GOST 1050-
88. Cooling of the built-up layer takes place in air.

For research of microstructure of the built-up coat-
ings, sections were produced by mechanical grinding 
and subsequent polishing in accordance with standard 
technique [12].

The qualitative and quantitative metalgraphic 
analysis is carried out by the scanning electronic 
microscope ZEISS EVO40XVP, which is equipped 
with detectors of secondary electrons, reflected elec-
trons and x-ray spectrometer. The analysis of micro-
structures of the built-up layers obtained by electron-
microscopic method is carried out by means of spe-
cialized software package for processing and analysis 
of images «ImageJ». Sequence of the analysis is the 
following. The large-scale tags of 100 microns in size 
were put in pictures of microstructures (Figure 2, a, 
b); the image was stored with extension 800×600 pix-
els at the gif format. Then, the image was changed 
in binary one (black-and-white) by means of teams: 
“File →Open →Image →Adjust →Threshold”. The 
ratio between distances was established in pixels 
and millimeters for appropriate scale in the menu 
“Analyze→Set scale”. After that, using tab “Find 
Edges” in the menu “Process”, the contours of par-
ticles were found (Figure 3); then, in the tab “Analyze 
Particles” of the menu “Analyze” the range of mea-
surements was established.

For the specified structures, distribution of sizes 
and shape (rotundity degree C) of particles were de-
termined by a formula:

 24 SC
P

 
= p 

 
,  (2)

where S – area, P – particle perimeter. 
Uniformity of particles distribution in matrix met-

al was evaluated by distribution of binding by ran-
dom linear intercept method. The distance between 
intercepts was 50 microns, the spots of crossing of 
binding and intercepts were determined by impos-
ing of pictures of structure on their images and sub-
traction by command: “Process → Image Calculator 
→Substract”. The pieces obtained by this method 

Figure 2. Fragments of built-up layers microstructure: a – surfacing of an electrode with the powder TiC as filler; 
b - surfacing of an electrode with the mix Ti + C as filler

a b
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were measured by the command “Analyze Particles” 
as it was mentioned above.

Mathematical processing of the statistical data ob-
tained during the analysis of built-up layers micro-
structures was conducted with use of software pack-
age «OriginPro 8» for data numerical analysis.

Wear resistance of coatings under investigation 
was determined under the conditions of friction on 
fixed abrasive in the MT-1 installation using the 
technique described in the paper [13]. The abrasive, 
which is used, poses grinding wheels made of green 
silicon carbide of grade 64C F46 K 7 V according to  
GOST P 52781-2007 with a grain size of 425-355 mi-
crons and diameter of 300 mm and 40 mm in thick-
ness. The wear was determined as arithmetic-mean 
value of weight loss after three results of tests for 
each sample.

3. Results and their discussion
Nature of reinforcing particles distribution (in-

cluding carbide, boride, etc.) on sizes, their shape 

(spherical, cut, acicular, etc.), and also character 
of mutual arrangement in the built-up layers when 
wear-resistant arc surfacing are the most impor-
tant indicators defining their operational proper-
ties, first of all abrasive wear resistance and crack 
resistance [1, 3, 14]. With increase in the mainte-
nance of carbide phase, wear resistance increases 
monotonously due to growth of protective action of 
carbide particles in relation to intercarbide layers 
of metal binding [1]. At the same time, components 
with complex geometry in structure (for example, 
the eutectic formations) complicate evaluation of 
phase structure and, as a result, of predicted prop-
erties. 

Results of measurement of particles distribution in 
accordance with sizes (Figure 4) show that the aver-
age size of particles (28 microns) in the layer, which 
is built up at combination with SPHTS, is almost 
twice bigger than for surfacing with use of the pre-
pared powder TiC as filler. Thus, in both cases, nature 

a b
Figure 3. The processed fragments of built-up layers microstructure: a – surfacing of an electrode

with the powder TiC as filler; b - surfacing of an electrode with the mix Ti + C as filler

Figure 4. Nature of carbide particles distribution according to the size in the layer obtained when surfacing by electrode 
with mix Ti + C as filler (continuous lines) and when surfacing by electrode with powder TiC as filler (shaped lines)
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of distribution is described with high probability by 
lognormal law of distribution:
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where Ko, A, w, rc – parameters of the equation, which 
values are presented in Table 2.

As can be seen from Table 2, dispersion of par-
ticles at surfacing combination with SPHTS, as well 
as their sizes, is almost twice higher in comparison 
with surfacing by the powder TiC.

Thus, the layer obtained at surfacing combina-
tion with SPHTS is characterized by 2 times bigger 
particles of wear resistant reinforcing phase (which 
quantity is more than 50%); in turn, it predetermines 
the increased wear resistance under the conditions of 
abrasive wear. For example, according to data [15], 
two times increase of the size of carbide particles 
leads to increase in abrasive wear resistance by 30%. 

Besides the size of particles, geometrical param-
eters of their shape have significant impact on wear 
resistance. The strengthening phase in an alloy in the 

Table 2. Parameters of particles distribution

Surfacing method

Parameters

Ko w A rc

Dispersion, %
22 2ln( )( 1) cr wwD e e += −

Powder mix Ti+C 0,37 0,41 162,21 10,58 24,95
Powder TiC 0,32 0,27 167,85 23,18 47,29

form of arborescent inclusions worsens the uniformi-
ty of its distribution, and also reduces its maximum 
possible concentration in alloy; therefore, under the 
conditions of abrasive wear, the strengthening phase 
in the form of equiaxed particles, which are uniform-
ly distributed throughout an alloy, is the most prefer-
able [16]. Moreover, in case of increase of deviation 
degree of particles shape from the spherical one, the 
degree of their polyhedron and structure branching 
increases; this creates a significant amount of stress-
risers and, as a result, causes significant reduction of 
crack resistance.

The analysis of rotundity of particles shape (Fig-
ure 5) shows main distinction depending on surfacing 
method: the maximum quantity of particles (~ 25%) 
at SPHTS surfacing is characterized by rotundity de-
gree of ~ 0.7, and at surfacing by powder TiC; this 
indicator is approximately 3 times lower (for the 
majority of particles (~ 25%), degree of rotundity is  
~ 0,2). It should be noted that nature of particles dis-
tribution according to the shape is described by the 
law of Gauss for SPHTS surfacing, and at surfacing 
by powder TiC is described by lognormal one. It testi-
fies that in the first case, uniform distribution of more 
rounded particles takes place; this has positive impact 

Figure 5. Nature of carbide particles distribution on rotundity in the layer obtained when surfacing by electrode 
with mix Ti + C as filler (continuous lines) and when surfacing by electrode with powder TiC as filler (shaped lines)
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on firmness of the built-up layer under the conditions 
of shock loads owing to crack resistance increase. 

Properties of the heterophase composite coatings 
consisting of firm carbide inclusions and rather plas-
tic steel binding depend significantly on uniformity of 
its distribution that is on size of intergranular layers. 
At low values of this parameter, high probability of 
emergence of “dry” contacts of carbide-carbide takes 
place that leads to significant reduction of strength 
properties (shear and compressive strength) [17]. As 
can be seen from nature of distribution of binding 

according to size, there are significant distinctions 
structures under investigation (Figure 6): surfacing 
by SPHTS method with high reliability is described 
by lognormal law with average value of 18 microns 
as against the layer obtained by surfacing with pow-
der TiC, where distribution of binding is submitted to 
exponential law, and thus, the majority of layers have 
the sizes of ≤ 1 microns. Thus, in the second case, 
there is much more substantial risk of cracks on the 
fragments forming skeletal conglomerates with the 
subsequent separation from a basis.

Figure 6. Nature of intergranular layers according to the sizes in layer obtained when surfacing by electrode 
with mix Ti + C as filler (continuous lines) and when surfacing by electrode with powder TiC as filler (shaped lines)

Results of tests on determination of abrasive wear 
resistance of coatings under investigation have shown 
that the layers, which are obtained by surfacing using 
electrode with mix Ti + C as filler have wear resis-
tance by1.27 times higher in comparison with layers, 
which are built up by an electrode with prepared pow-
der TiC as filler; it is in line with the revealed differ-
ences of their microstructural parameters.

4. Conclusions
1. The comparative analysis of microstructures 

of built-up layers obtained by traditional surfacing 
with use of prepared titanium carbide and surfacing 
at combination with SPHTS have shown significant 
impact of SPHTS on final structure of the built-up 
coatings.

2. The microstructure of the layers obtained at 
combination of surfacing with SPHTS is character-
ized by the average size of particles (28 microns), 
which is twice bigger than for surfacing with use of 
prepared powder of titanium carbide as filler.

3. Nature of particles distribution according to the 
size is described by the law of Gauss for combination 

of surfacing with SPHTS and at surfacing by powder 
TiC is described by lognormal law; this testifies that 
in the first case uniform distribution of particles takes 
place. Moreover, the analysis of rotundity of particles 
shape has shown that at combination of surfacing 
with SPHTS, titanium carbide particles are character-
ized by rotundity degree of ~ 0.7, and at surfacing by 
powder TiC, this indicator is 3 times lower, degree 
of rotundity is ~ 0.2; that is conductive to growth of 
wear and crack resistance.

4. The study of nature of distribution of binding 
according to the size have shown that surfacing com-
bined with SPHTS provides distribution of binding in 
accordance with lognormal law with average value of 
18 microns as against the layer obtained by surfacing 
by prepared powder of titanium carbide, where dis-
tribution of binding is submitted to exponential law, 
and thus, the majority of layers have the sizes of ≤ 1 
microns.

5. The tests of determination of abrasive wear re-
sistance of coatings under the conditions of friction 
on fixed abrasive have shown that layers, which are 
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obtained by surfacing combined with SPHTS, have 
wear resistance by1.27 times higher in comparison 
with layers, which are built up by an electrode with 
prepared powder of titanium carbide.
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